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머 리 말 

위대한�령도자�김정일대원수님께서는�다음과�같이�지적하시였다.�

《현대과학기술의 기초는 콤퓨터입니다. 콤퓨터가 출현하고 그에 따라 정보기술이 발전하면서 

사람들이 환상적으로만 생각하던 문제들이 현실로 되고있으며 자연을 정복하고 세계를 개조하는 

인간의 창조적힘은 더욱더 위력한것으로 되고있습니다.》 

위대한�령도자�김정일대원수님의�현명한�령도에�의하여�오늘�우리�나라에서는�정보기

술을�빨리�발전시킬수�있는�물질기술적토대가�튼튼히�마련되였으며�새로운�정보기술성과들

이�련이어�이룩되여�인민경제�여러�부문의�정보화,�콤퓨터화가�높은�수준에서�실현되고있

다.�인민경제의�정보화는�콤퓨터를�떼여놓고�생각할수�없으며�콤퓨터기술을�발전시켜야�인

민경제의�정보화를�적극�다그쳐나갈수�있다.�

오늘�콤퓨터기술을�소유하는것은�사회성원으로서�응당�갖추어야�할�필수적인�자질로�

된다.�특히�콤퓨터망에서의�정보관리와�필요한�정보를�다매체편집물로�표현할줄�아는것이�

매우�중요하다.�

위대한�령도자�김정일대원수님께서는�우리�학생들이�강성대국을�떠메고나갈�훌륭한�

인재들로�자라나도록�하시기�위하여�크나큰�사랑을�돌려주시였다.�

6학년�《콤퓨터》에서는�콤퓨터망의�리용방법과�홈페지의�작성방법을�배우며�다매체

편집물을�작성할수�있는�초보적인�지식에�대하여�배우게�된다.�

먼저�콤퓨터망을�통하여�필요한�정보를�수집하고�활용해나갈수�있도록�하기�위하여�콤

퓨터망의�일반적개념과�그�리용방법�및�콤퓨터망에서의�홈페지작성방법에�대한�기본적인�

지식을�배우게�된다.�그리고�여러가지�다매체창작도구들을�리용하여�다매체작품을�만드는�

일반적인�방법에�대하여�배운다.�

우리는�콤퓨터에�대한�학습을�열심히�하여�우리의�사회주의강성대국을�과학과�기술로�

떠메고나갈�유능한�인재로�튼튼히�준비함으로써�위대한�령도자�김정일대원수님의�크나큰�

믿음과�기대에�보답하여야�한다.�

�

�
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제1장. 홈페지만들기 

제1절.�홈페지에�대한�개념�

1. 인터네트와 웨브의 개념 

우리가� 사용하고있는� 콤퓨터통신망에는� 국부망(LAN),� 지역망(MAN),� 광지역망

(WAN)을�비롯하여�수많은�통신망이�있다.�이러한�매�통신망들은�서로�다른�하드웨어나�

통신규약정보를�공유하거나�협조체계를�구성하기가�힘들었다.�

오늘의�정보시대에�알맞게�전세계적인�범위에서�다양하고도�신속한�정보교환문제를�원

만히�해결하기�위하여�서로�다른�콤퓨터통신망들을�련결시킬수�있는�통일적인�통신규약

(TCP/IP)에�기초하여�세계각지의�국부적인�망들을�하나로�련결시킨�세계적인�광지역망을�

인터네트라고�한다.�즉�인터네트는�세계적규모에서�호상�접속된�콤퓨터망환경이라고�말할수�

있다.�

특정한�조직내의�각�콤퓨터는�국부망에서�나란히�련결되며�이�국부망에서의�임의의�마

디점은�모두�인터네트와�물리적으로�접속되므로�인터네트에�접속한�매�콤퓨터들은�모두�인

터네트의�다른�콤퓨터들과�직접�련결되게�된다.�따라서�인터네트는�콤퓨터들의�망이라고�

말하기보다는�망들사이의�망이라고�하는것이�더�적합하다.�

�

�
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�
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�
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현재�인터네트는�수십억의�콤퓨터와�사용자들을�망라하고있다.�

인터네트에서는�접속된�콤퓨터를�통하여�어떤�정보자료에�접근하면�그것과�련관된�문

서들이�세계의�그�어디에�있든지�자동적으로�찾아갈수�있다.�그러므로�인터네트를�통하여�

새로운�경제정보,�과학기술정보,�새�소식�등과�같은�많은�정보자료들을�봉사받게�되여�그�

사용자가�점점�늘어나고있다.�

인터네트에서�열람기(Browser)라고�하는�말단봉사프로그람을�리용하여�사용자는�간

단한�마우스의�사용으로�여러�봉사기에로�이동하면서�각이한�정보를�손쉽게�열람할수�있다.�

국부망�

콤퓨터�

인터네트� 마디점



�4�

이와�같은�문서방문체계가�바로�WWW(World�Wide�Web:�세계적인�망)�혹은�간단히�웨

브(Web)라고�하는�망응용체계이다.�웨브의�정보구성단위는�여러가지�이름으로�불리우는데�

그가운데서�가장�자주�쓰이는것은�콤퓨터의�한화면에서�볼수�있는�자료인�페지(page)와�문

서(document),�자원(resource)이다.�보통�페지는�본문,�도형,�비데오,�화상,�음성�및�그�

결합체인�다매체로�구성된다.�

웨브에서는�URL(Uniform-Resource�Locator:�유일자원지시기)이라고�하는�주소를�

사용하는데�이것은�인터네트싸이트,�웨브페지�또는�웨브페지에�포함된�그림들과�같은�정보

들의�위치를�표시하기�위해�사용하는�주소이다.��

우리는�모든�인터네트설비를�이름으로�식별하지만�콤퓨터는�수자주소로�식별한다.�그

러므로�우리가�사용하는�서로�다른�이름을�가진�각종�설비들을�콤퓨터가�사용하는�수자기

억기주소와�대응시키는�일종의�엄격한�대응관계가�필요하다.��

인터네트에�련결되는�매개�설비의�인터네트규약(IP)주소는�유일한�32bit수자인데�IP

주소는�보통�4개�조의�8bit수자로�쓰고�점으로�분할한다.�이런�표시방식은�련관주소모임을�

지정하기�쉬우며�인터네트의�경로콤퓨터가�통보의�다음방향을�판단하는데도�편리하다.�

각종�조직들은�많은�IP주소토막을�가지고�차례로�그�주소를�인터네트에�접속해야�할�

설비들에�분배하는데�여기에는�절대다수의�콤퓨터들이�포함된다.�례를�들어�하나의�작은�

규모의�단체는�191.57.126.0부터�191.57.126.255까지와�같이�256개의�IP주소를�얻을수�

있으며� 매우� 큰� 기구는� 첫� 8bit수자가� 특수한� 모든� IP주소� 례컨대� 12.0.0.0부터�

12.255.255.255까지와�같은�1�600만여개의�IP주소를�얻을수�있다.��

사람들이�우에서와�같은�IP주소의�수자들을�처리하거나�기억하기�힘들므로�인터네트

우의�설비는�문자화된�이름도�가지고있다.�이런�이름의�시작부분은�주콤퓨터이름이고�뒤부

분은�점차�커지는�닫긴�기계모임�즉�령역(domain)인데�두개,�세개�또는�그�이상의�령역이

름이�있을수�있다.�실례로�콤퓨터주소�com1.sec.edu.kp에서�com1은�주콤퓨터이름이고�

sec는�주콤퓨터�com1의�국부령역이다.�그리고�sec령역은�edu령역의�일부분이며�또�edu

령역은�kp령역의�일부분이다.��

웨브에서의�주소는�다음과�같이�구성되여있다.�

규약이름://콤퓨터주소(:포구번호)/등록부경로/문서이름 

실례:�http://com1.sec.edu.kp�

�����http://com2.sec.edu.kp/mydata/myschool.html��

웨브와�인터네트는�서로�다르다.�인터네트가�호상통신을�진행할수�있는�장치를�통하여�

서로�련결된�콤퓨터�및�기타�설비들의�모임이라면�웨브는�쏘프트웨어와�규약들의�모임이며�

이러한�쏘프트웨어와�규약들은�인터네트의�모든�또는�절대다수의�콤퓨터에�설치된다.��
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어떠한�추상적의미로�말하면�웨브는�하나의�거대한�문서의�모임이며�그가운데서�일부�

문서들은�서로�련결되였으며�웨브열람기를�사용하여�이�문서들을�방문하며�웨브봉사기는�

이런�문서들을�제공해준다.�

웨브열람기는�가장�간단한�경우에�문서를�제공해주는�웨브봉사기에게�어떤�문서를�방

문하겠다는�요청을�보내고�웨브봉사기는�문서를�찾아�웨브열람기에게�보내주며�웨브열람기

는�그�문서를�사용자에게�현시해준다.��

비록�웨브가�많은�규약을�지원하지만�가장�자주�쓰이는것은�직접�웨브문서를�지원하는�

하이퍼본문전송규약(HTTP)이다.�HTTP는�웨브열람기와�웨브봉사기사이에�통신을�진행하

는�일종의�표준형식을�제공한다.�인터네트는�TCP/IP통신규약,�웨브봉사기와�웨브열람기,�

홈페지(Home�Page)�또는�하이퍼본문서술언어�HTML,�하이퍼본문전송규약�HTTP와�같

은�국제표준들을�리용한다.��

콤퓨터망이나�자료통신에서는�통신규약(Protocol)이라는것이�중요한�개념으로�쓰인다.�

통신규약이란�콤퓨터망에�존재하는�기계(콤퓨터나�콤퓨터주변장치)들사이에�통신이�이

루어지기�위한�약속과�규칙들의�총체를�말한다.�말하자면�콤퓨터의�자료들은�모두�수자자

료�즉�비트나�바이트로�이루어졌으므로�그것들이�통신될�때�무엇을�의미하며�어떤�의미를�

가지고�언제�어떻게�통신되여야�하는가를�공통짓기�위한�약속과�규칙들의�총체가�바로�통

신규약이라고�할수�있다.�

모든�콤퓨터망체계는�독립적인�하나의�작은�기능을�수행하는�층들로�구성되므로�통신

규약은�여러개의�단순한�통신기능준위를�약속하는�계층구조로�이루어진다.�다시말하여�통

신쌍방의�대응하는�층마다에�해당한�규약이�존재한다.��

콤퓨터망체계에서�계층과�통신규약의�묶음을�망구성방식(Network�Architecture)이라

고�한다.�

현재�세계적으로�일반화된�콤퓨터통신규약에는�TCP/IP,�FTP와�HTTP,�하이퍼본문�

등이�있다.�

인터네트에서는�다른�종류의�콤퓨터들과�통신을�진행할�때�TCP/IP를�사용한다.��

TCP/IP(Transmission�Control�Protocol/Internet�Protocol:�전송조종규약/인터네트

규약)통신규약은�인터네트를�비롯하여�일반적인�국부망들�그리고�인트라네트(Intranet)�등�세

계적으로�가장�널리�리용되는�통신규약이다.��

TCP/IP는�콤퓨터망의�조상인�Arpanet와�그�계승자인�인터네트에서�연구되고�리용

된�통신규약이다.�인터네트는�1969년에�구축한�Arpanet로부터�발단되였는데�1980년대에�

여러�대학이나�연구기관의�망을�련결하는�련합망으로�급속히�발전하였다.�1982년에�TCP�

/IP규약은�콤퓨터망접속의�표준규약으로�되였으며�두�콤퓨터가�인터네트를�통하여�서로�

련결될수만�있다면�한대의�콤퓨터에서�실행되는�프로그람이�직접�다른�콤퓨터에서�실행되

는�프로그람과�통신을�진행할수�있게�하였다.��
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FTP와�HTTP는�TCP/IP보다�웃준위의�통신규약으로서�TCP/IP통신규약이�제공되

여있는�망에서�사용할수�있다.��

FTP(File�Transfer�Protocol:�파일전송규약)는�인터네트에�있는�원격체계와�문서를�

주고받기�위한�통신규약이다.��

FTP는� 원격체계에� 대한� 접속(Login),� 등록부(Directory)옮기기,� 현재등록부

(Current�Directory)의�목록제시,�문서를�국부적인�체계에�내리적재(Download)�등을�

할수�있다.��

HTTP(Hyper�Text�Transfer�Protocol:�하이퍼본문전송규약)는�HTML문서를�주

고받기�위한�통신규약이다.��

HTML문서를�보여주고�HyperLink(초련결)로�련결된�문서에�쉽게�접근할수�있는�열

람기에�의하여�HTTP는�현재�가장�보편적인�인터네트통신규약으로�되였다.��

HTTP는�문자정보뿐아니라�그림,�동화상을�비롯한�다매체자료는�물론�봉사기와의�련

계를�통하여�봉사기쪽의�프로그람을�수행시킬수�있으므로�문서와�응용프로그람을�통합하는�

매체로�발전하고있다.��

2. 홈페지의 개념 

콤퓨터망에서�리용되는�문서들은�보통�하이퍼본문과�하이퍼매체의�개념을�리용한다.��

하이퍼본문(Hyper�Text)이라는�말은�일반본문의�기능을�초월하는�본문문서라는�뜻을�

가지는데�콤퓨터본문문서에서�련관된�정보들이�매듭이라고�하는�실마리단어를�통해�유기적

으로�련결된�방식을�말한다.�여기서�매듭(node)은�하나의�정보를�포함하고있는�단위이며�

련결(link)은�매듭사이를�련결하는것을�말한다.�콤퓨터의�기억능력과�검색능력을�활용하여�

정보를�탐색할�때�문서에�련결된�항목들을�선택함으로써�다른�문서에로�옮겨갈수도�있다.�

하이퍼본문문서는�본문만을�포함하는�반면에�하이퍼매체(hypermedia)문서는�그림，도형,�

음성도�포함할수�있다.��

하이퍼본문이나�하이퍼매체의�단위를�웨브에서는�페지라고�한다.��

홈페지(home�page)란�원래�뜻으로�말하면�첫�페지라는것이다.�

일반적으로�우리가�책을�읽을�때�차례를�보고�필요한�페지를�펼쳐보는것과�마찬가지로�

홈페지는�쉽게�말하여�책의�차례를�담은�첫�페지라고�할수�있다.�

콤퓨터망을�통하여�전송되는�자료가�여러�부분으로�이루어져있을�때�그�자료를�받아보

는�사람이�처음으로�보게�되는�화면�즉�페지를�홈페지라고�불러왔다.�

그러나�오늘날에�와서는�처음으로�보게�되는�페지뿐만아니라�그것과�련결되는�자료전

체가�홈페지라는�의미로�리용되고있다.�

오늘�홈페지는�본문,�화상,�음성,�동화상�등의�다매체정보로�이루어져있으며�망을�통

하여�전송되여�많은�각이한�사용자들이�리용하는�특성으로�하여�일정한�규칙에�의하여�작

성된다.�
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그러한�규칙에�의하여�홈페지를�작성할수�있게�하는�언어가�바로�하이퍼본문생성언어

HTML(Hyper�Text�Markup�Language)이다.�

하이퍼본문생성언어�HTML은�홈페지를�작성할�때�리용하는�페지작성언어이다.�영문

단어�Markup�language는�책출판업에서�유래된것이다.�책을�출판하려면�인쇄하기�전에�

본문을�어떻게�형식화할것인가,�실례로�어떤�본문을�굵은�문자로�인쇄하도록�그�본문밑에�

물결선을�긋는것과�같이�여러가지�약속된�표식을�해놓는데�이것이�바로�Markup이다.��

마찬가지로�홈페지에�대한�자료도�열람기가�해석할수�있게�형식화된다.�

HTML은�본문,�화상,�영상,�음성�등�각이한�정보들을�홈페지에�어떻게�표시하겠는가

를�약속된�형식으로�서술한다.�

홈페지는�머리와�본체의�두�부분으로�이루어진다.��

머리는�홈페지의�첫�부분이다.�머리는�그�페지의�제목과�열람기가�리용하게�될�기타�

파라메터를�포함한다.��

홈페지의�실지�내용은�본체이다.�이것은�본문과�표식들을�포함한다.�본문은�페지에�포

함되여있는�실지�정보이며�표식은�문서의�표시를�정의한다.��

모든�HTML표식은�선택적인�속성목록이�뒤따르는�이름이며�전체는�괄호�<�>안에�놓

인다.�

3. 홈페지의 열람 

홈페지의�열람은�《내나라》열람기를�리용하여�진행할수�있다.�

《붉은별�2.0》에는�《내나라》열람기�2.5가�표준으로�적재되여있다.��

홈페지는�콤퓨터망에서�리용되는�문서이므로�홈페지를�열람하려면�우선�콤퓨터를�망에�

가입시켜야�한다.��

《시작》→《내나라》열람기�2.5지령을�실행하거나�탁상면에서�그림기호�� 를�찰

칵하면�《내나라》열람기�2.5가�펼쳐진다.�

�
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여기서�도구띠아래에�《내나라》,�《한마음》,�《국가망정보쎈터》,�《중앙과학기술통

보사》라고�쓴�띠가�있는데�이�띠를�리용하여�가입하고싶은�망의�홈페지를�펼치고�자료열

람을�할수�있다.�

홈페지에는�다음과�같은것들이�있다.�
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� 만경대정보쎈터홈페지 

중앙정보통신국홈페지 

김책공업종합대학 



� 9

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

정보산업지도국(KCC-조선콤퓨터쎈터)오산덕정보쎈터홈페지 

평양정보쎈터(PIC)홈페지 
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과학기술통보사홈페지 

인민대학습당홈페지 
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《붉은별�2.0》체계에서�망에�가입하기�위해서는�우선�자기�콤퓨터의�망자원�

즉�망모뎀이�준비되여야�하며�또한�모뎀의�해당�Driver를�체계에�설치해주어야�

한다.�다음으로�망가입을�위해서는�자기�콤퓨터의�망주소를�설정해주어야�하며�

망장치의�입출력포구를�설정해주어야�한다.�

�

알아두기

조선중앙방송위원회홈페지
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다음으로�망에�가입하기�위해서는�해당�자기의�등록된�이름과�암호를�

중앙관리소(국가망정보쎈터)에�등록된�자기의�정보와�비교해야�한다.�

그러기�위해서�자기의�이름과�암호를�입력해주고�망에�접속하기�위한�

KPPPoE라는�프로그람을�동작시켜야�한다.�

거기서�《사용자이름》칸에�자기의�등록된�이름을�써넣고�《접속암호》칸

에�등록된�자기의�암호를�입력하고�《접속》단추를�찰칵한다.�

그래야�망관리자�즉�국가망정보쎈터에�있는�관리자가�정보를�확인하고�

망에�가입할�권한을�준다.�

그러면�망에서�자기가�열람하려고�하는것을�마음대로�할수�있다.�

�
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�

그러면�화면에�다음과�같은�창문이�펼쳐진다.�

�

�

�

�

�

�

�

이때�이�창문에서�OK단추를�찰칵하고�과제띠의�그림기호� 를�찰칵하

면�《내나라》열람기�2.5가�펼쳐지는데�여기서�자기가�접속하고싶은�망에�접

속하여�자료열람을�하면�된다.�
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제2절.�《전자도서관》�

HTML은�프로그람작성언어가�아니다.�그것은�계산과정을�서술하는데는�리용할수�없

고�오직�웨브열람기가�현시하는�문서들의�일반형식과�설계에�대하여�서술하기때문이다.�

HTML문서는�기본내용자료와�그를�배치하고�형식화하기�위한�예약어들로�이루어져있

는데�예약어들은�괄호�<�>로�둘러싸여있다.�이�예약어들을�꼬리표(tag)라고�하는데�이것들

은�실지�홈페지를�펼쳐볼�때에는�나타나지�않는다.�

HTML문서작성은�《본문편집기》를�리용하여�진행할수도�있고�웨브개발도구를�리용

하여�진행할수도�있다.�

《본문편집기》를�리용하여�《전자도서관》홈페지를�작성하는�과정을�통하여�HTML

의�기본문법을�학습하기로�한다.�

1. 도서목록의 작성 

《전자도서관》홈페지에는�무엇보다도�해당�도서관에�들어있는�도서들을�보여주는�도

서목록이�있어야�한다.�

도서목록을�작성하자면�도서를�과목별,�종류별로�분류하여야�한다.�

그리고�분류된�도서들에�대한�목록을�작성하기�위하여�문자들을�입력하고�본문과�페지

의�형식화를�진행하며�표를�작성하고�내용을�추가하여야�한다.�

1)�HTML문서작성방법�

HTML문서에서는�꼬리표를�리용하여�본문에�대한�입력과�형식화를�진행한다.�

모든�HTML문서에는�4개의�꼬리표�<HTML>,�<HEAD>,�<TITLE>�및�<BODY>가�

필요하다.�

실례:�《시작》→《응용프로그람》→《보조프로그람》→《본문편집기》지령을�실행하

여�본문편집기를�펼치고�다음과�같이�입력한다.�

<HTML>�

<HEAD><TITLE>�문자의�크기</TITLE></HEAD>�

<BODY>�

<FONT�SIZE="1">전자도서관1�

</FONT><BR>�

<FONT�SIZE="2">전자도서관2��

</FONT><BR>�

<FONT�SIZE="3">전자도서관3�

</FONT><BR>�

<FONT�SIZE="4">전자도서관4��

</FONT><BR>�
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<FONT�SIZE="5">전자도서관5�

</FONT>�

</BODY>�

</HTML>�

파일차림표의�《다른�이름으로�보관》지령이나�도구띠의�파일보관그림기호를�찰칵하여�

문서보관대화칸을�펼치고�우의�문서를�례하면�1-1.html이라고�이름을�달아�보관한다.�

�

《내나라》열람기를�펼치고�《파일(F)》→《파일�열기》지령을�실행하여�나타나는�파

일열기대화칸에서�1-1.html문서를�열어보면�다음과�같다.�

�
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실례에서�<HTML>꼬리표는�오직�문서가�HTML을�리용하여�작성된것이라는것만을�

표시한다.�따라서�정상적인�경우에�HTML문서는�모두�꼬리표�<HTML>로�시작되며�꼬리

표�</HTML>로�끝난다.�

꼬리표�<HEAD>와�</HEAD>는�각각�문서의�머리부의�시작과�끝을�표시한다.��

또한�<BODY>는�몸체부분의�시작을�표시한다.�HTML문서는�머리부와�본체�두�부분

으로�구성되였다.�문서의�머리부는�문서의�내용이�아니라�문서와�관계된�정보를�제공한다.�

본체꼬리표사이의�내용이�문서의�내용이며�내용안에�사용한�꼬리표는�열람기가�어떻게�그�

부분의�내용을�현시해야�하는가를�지시한다.��

꼬리표�<TITLE>과�</TITLE>사이의�본문은�열람기에�의해�현시창문의�제목띠안에�

표시된다.�

모든�꼬리표들은�<HTML>과�같은�시작꼬리표와�/기호가�들어가있는�</HTML>과�

같은�끝꼬리표가�있어야�한다.�

실례에서�보여주는바와�같이�머리부의�시작꼬리표�<HEAD>와�함께�머리부의�끝을�의

미하는�끝꼬리표�</HEAD>가�있으며�제목을�의미하는�시작꼬리표�<TITLE>�다음에�제목

이�있고�그것이�끝나면�끝꼬리표�</TITLE>이�있다.��

실례에는�<BR>꼬리표도�있는데�이�꼬리표는�행바꾸기를�하는�기능을�준다.�<BR>는�

끝꼬리표를�가지지�않는다.�

행바꾸기에는� <P>꼬리표도�있는데�이것은�행을�바꾸면서�빈�행을�하나�삽입한다.�

<P>꼬리표는�끝꼬리표를�가진다.�

2)�문자의�크기,�색,�서체�설정�

문자의�크기,�색,�서체는�FONT꼬리표를�리용하여�설정한다.�

FONT꼬리표의�형식은�다음과�같다.�

<FONT�SIZE=“수값”��

�������COLOR=“색값”�

�������FACE=“서체명”>�

…�

</FONT>�

SIZE는�문자의�크기를�나타내는�속성으로서�수값으로는�1~7사이의�값이�설정될수�있

다.�여기서�1은�제일�작은�문자를�나타내고�7은�제일�큰�문자를�나타낸다.�

COLOR는�문자의�색을�나타내는�속성으로서�색값은�16진수로�표시되는�형식을�쓸수�

있다.�즉�R(RED:�붉은색),�G(GREEN:�풀색),�B(BLUE:�푸른색)의�합성이라는�의미에

서�#RRGGBB형식으로�되여있다.�실례로�#000000은�검은색,�#FF0000은�붉은색,�#00FF�

00은�풀색,�#0000FF는�푸른색,�#FFFFFF는�흰색으로�표시된다.�
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FACE는�문자의�서체를�나타내는�속성으로서�서체명은�현재�체계가�지원하는�모든�서

체이름들이�다�리용될수�있다.�

실례로�우리�글�서체의�《청봉》체를�리용하려�한다면�KPChongbong�또는�WKL�

Chongbong이라고�입력하면�된다.�

3)�문자의�형식화,�문서목록화,�특수문자입력�

-�문자의 형식화�

문자의�형식화에는�굵게�쓰기,�비껴쓰기,�밑선긋기,�중간선긋기�등의�내용이�포함된다.�

굵게�쓰기는�<B>,�비껴쓰기는�<I>,�밑선긋기는�<U>,�중간선긋기는�<S>꼬리표로�정

의된다.�또한�웃첨수붙이기는�<SUP>,�아래첨수붙이기는�<SUB>로�서술한다.�

실례:��

<HTML>�

<HEAD><TITLE>글자의�속성�

</TITLE></HEAD>�

<BODY>�

<B>굵은�글자를�표시</B><BR>�

<I>약간�비껴쓴�글자를�표시</I><BR>�

<U>글자에�밑선긋기</U><BR>����������

<S>글자에�중간선긋기</S><BR>�

A<SUP>2</SUP>+B<SUP>2</SUP>=0<BR>�

</BODY>�

</HTML>�

�
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-�문서목록화�

번호붙이기와�표식붙이기는�<UL>,�<LI>,�<OL>꼬리표들로�정의한다.�

<UL>꼬리표는�표식목록의�문서가�시작된다는것을�표시하고�<LI>는�항목표식을�설정

하며�<OL>은�번호목록의�문서가�시작된다는것을�표시한다.�

<LI>꼬리표는�끝꼬리표를�요구하지�않는다.�

실례:��

<UL>�

<LI>수학������

<LI>물리�

<LI>화학�

<LI>생물�

</UL>�

<OL>�

<LI>수학�

<LI>물리�

<LI>화학�

<LI>생물�

</OL>�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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정의목록은�<DL>,�<DT>,�<DD>꼬리표들로�정의한다.�

<DL>꼬리표는�정의목록시작을�표시하며�<DT>꼬리표는�열쇠로�되는�단어앞에�붙이고�

<DD>꼬리표는�해설문의�앞에�붙인다.�

실례:��

<DL>�

<DT>수학�

<DD>여기서는�대수,�기하,�해석학�등의�교과서�및�참고서들을�취급합니다.�

<P>������

<DT>외국어�

<DD>여기서는�영어,�로어,�중국어�등의�교과서�및�참고서들을�취급합니다.�

</DL>�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

특수문자의�입력은�&기호와�;기호로�둘러막힌�문자로�서술한다.�

아래의�표에�특수문자표를�주었다.�
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표 시 서 술 설   명 

<� &lt;� 안같기식기호로�사용�

>� &gt;� 안같기식기호로�사용�

&� &amp;� 문자�&로�사용�

(공백)� &nbsp;� 여러개의�공백을�련속하여�서술할수�있다.�

� &copy;� 저작권기호를�표시�

×� &times;� 곱하기기호로�사용�

"� &quote;� 인용부호속에서�문자로�사용�

�

이밖에�문서형식화를�위한�여러가지�꼬리표들이�있다.�

<PRE>꼬리표는�문서를�그대로�표시하는�기능을�주며�<CENTER>꼬리표는�문서를�

화면의�중심에�표시한다.�

<DIV>꼬리표는�문장의�표시위치를�설정하는�기능을�준다.�

<DIV�ALIGN="left">:�문장들을�왼쪽으로�배치��

<DIV�ALIGN="center">:�문장들을�중심에�배치��

<DIV�ALIGN="right">:�문장들을�오른쪽으로�배치�

<P>꼬리표도�역시�ALIGN속성을�가지는데�그에�대한�설정은�다른�꼬리표들과�같은�

방법으로�해주면�된다.�

4)�페지의�배경색설정과�배경그림삽입�

홈페지는�어떤�측면에서�보면�직관적가치를�가져야�하는것만큼�배경의�형식을�중시하

게�된다.�

페지의� 배경색은� <BODY>꼬리표의� 속성을� 지적하는� 방법으로� 변경시킨다.� 즉�

<BODY�BGCOLOR="색값">꼬리표를�리용한다.�

실례:��

<BODY�BGCOLOR="#FFFFFF">�

������정열은�성공의�비결�

</BODY>�

페지에�깔아주는�그림도�역시�<BODY>꼬리표의�속성을�지적하여�설정할수�있다.�

페지의�배경그림은�<BODY�BACKGROUND="그림파일">꼬리표를�리용하여�깔아준다.�

실례:��

<BODY� BACKGROUND="file:///usr/share/backgrounds/images/선군8경/

철령의�철쭉.jpg">철령의�철쭉</BODY>�
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�
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�

�

문서의�본체내용안에�어떤�꼬리표도�없는�본문을�포함할수�있다.�

이때에는�열람창문에�단락과�빈�행들이�무시된�본문으로�현시된다.�

5)�페지우에�선그리기�및�그림삽입�

페지에�선을�그리려면�<HR>꼬리표를�리용한다.�

<HR>꼬리표는�SIZE,�WIDTH,�ALIGN�등의�속성을�가진다.�

SIZE속성은�선의�굵기를�설정하고�WIDTH속성은�선의�길이를�설정하며�ALIGN속성

은�선의�가로방향배치를�설정한다.�

실례:��

<HR>�

������<HR�SIZE="4"�WIDTH="100"ALIGN="CENTER">�

</HR>�

여기서�SIZE값은�화소수를�나타내며��WIDTH값은�페지의�가로길이에�대한�퍼센트

(%)를�나타낸다.�

페지우에�그림을�삽입하려면�<IMG>꼬리표로�삽입할수�있다.�

<IMG>꼬리표는�SRC,�ALIGN,�ALT,�BORDER,�HEIGHT,�WIDTH,�HSPACE,�

VSPACE�등의�속성을�가진다.�

SRC속성은�그림파일의�이름을�지정한다.�
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ALIGN속성은�그림과�본문을�함께�배치할�때�본문을�그림주위에�어떻게�배치하겠는가

를�설정한다.�

ALIGN속성이�가질수�있는�값들과�그�내용은�아래와�같다.�

TOP�-�본문을�그림의�꼭대기에�배치한다.�

MIDDLE�-�본문을�그림의�중간에서부터�배치한다.�

BOTTOM�-�본문을�그림의�밑에서부터�배치한다.�

LEFT�-�그림을�왼쪽에�배치하고�그�둘레에�본문을�배치한다.�

RIGHT�-�그림을�오른쪽에�배치하고�그�둘레에�본문을�배치한다.�

ALT속성은�그림이�없을�때�그대신�본문을�나타내는�속성이다.�

BORDER속성은�그림둘레에�테두리선을�표시하기�위한�속성이다.�

WIDTH속성은�그림의�너비를,�HEIGHT속성은�그림의�높이를�설정하기�위한�속성이다.�

HSPACE속성은�그림과�본문사이의�량옆여백을�설정하기�위한�속성이며�VSPACE속

성은�그림과�본문사이의�우아래여백을�설정하기�위한�속성이다.�

값은�화소수를�수자로�설정한다.�

실례:��

<IMG� SRC="file:///usr/share/backgrounds/images/선군8경/대홍단의�감자

꽃바다"ALIGN="LEFT"BORDER="5"��WIDTH="150"HEIGHT="70">�

�

�

�

�

�

�

�

�

�

�

�

�

�

6)�표작성�

HTML에는�표작성을�위한�<TABLE>꼬리표가�준비되여있다.�

<TABLE>꼬리표는�다음과�같은�속성을�가지고�표를�짜고�변경시킨다.�

BORDER�-�테두리선의�너비로서�값은�화소수를�지정한다.�

WIDTH�-�표의�너비로서�%값을�준다.�
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HEIGHT�-�표의�높이로서�%값을�준다.�

BGCOLOR�-�표의�배경색으로서�16진수값을�지정한다.�

BORDERCOLOR�-�테두리선의�색으로서�16진수값을�지정한다.�

BACKGROUND�-�표의�배경그림으로서�파일이름을�준다.�

실례:��

<TABLE�ALIGN="CENTER"�BGCOLOR="YELLOW"�FRAME="BOX"><BR>�

<BR><BR>�

��<CAPTION><STRONG><U>도서목록</U></STRONG></CAPTION>�

��<TBODY�ALIGN="CENTER"�VALIGN="CENTER"�BGCOLOR="CYAN">�

����<TR>�

������<TD>수학일화집</TD>�

������<TD>콤퓨터일화집</TD>�

����</TR>�

����<TR>�

������<TD>물리교과서</TD>�

<TD>화학교과서</TD>��

����</TR>�

��</TBODY>�

</TABLE><BR><U><A�HREF="1.HTML"><DIV�ALIGN="CENTER">도서내용

보기</DIV>�</A></U>�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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우의�실례에서�<TR>꼬리표는�표의�한개�행을�정의한다.�따라서�한개�행을�만들고�다

음행을�또�만들려면�<TR>꼬리표를�반복하여�써야�한다.��

<TR>꼬리표도�역시�ALIGN,�VALIGN,�BGCOLOR속성을�가진다.�이�속성들가운데

서�VALIGN속성은�행의�우아래배치를�설정하며�다른�속성들은�우에서�취급한�꼬리표들의�

속성과�설정방법이�같다.�

<TD>꼬리표는�행안에�세포를�만든다.��

<TD>꼬리표는�ALIGN,�VALIGN,�BGCOLOR,�ROWSPAN,�COLSPAN�등의�속

성들을�가진다.�

ROWSPAN은�세로방향으로�지정된�세포의�개수만큼의�높이를�가지는�세포를�작성하

며�COLSPAN은�가로방향으로�지정된�세포의�개수만큼의�너비를�가지는�세포를�작성한다.�

그밖의�다른�속성들은�다른�꼬리표들과�설정이�같다.�

2. 도서내용의 열람 

도서내용을�열람하기�위하여�도서목록의�매개�요소에�그�내용을�련결시켜야�한다.�

홈페지에서�어떤�본문이나�화상을�마우스로�찰칵하였을�때�그와�련관된�다른�페지�혹

은�다른�파일을�펼치는것을�하이퍼련결이라고�한다.�

하이퍼련결은�홈페지가�가지고있는�가장�중요한�기능이다.�

하이퍼련결은�본문이나�화상뿐만아니라�동화상이나�음성도�리용할수�있다.�

1)�본문을�통한�하이퍼련결�

본문의�하이퍼련결은�<A�HREF>꼬리표로�작성한다.�

실례:��

<A�HREF="filename.htm">�

같은�층에�있는�파일을�열람한다.�

</A><BR>�

<A�HREF="../filename.htm">�

바로�우의�층에�있는�파일을�열람한다.�

</A><BR>�

<A�HREF="/dirname/filename.htm">�

아래층에�있는�파일을�열람한다.�

</A>�

실례에서�보는바와�같이�련결하려는�파일이�현재�같은�서류철에�있는가,�아니면�웃준

위서류철에�있는가�혹은�아래준위서류철에�있는가�하는데�따라서�값형식이�달라진다.��

실례에서�작성한�본문들은�화면에�현시될�때�밑줄이�그어진�본문으로�나타나며�그�본

문들을�마우스로�찰칵하면�실례에서�지적된�파일들이�펼쳐지게�된다.�
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2)�화상을�통한�하이퍼련결�

화상을�통한�련결은�<IMG>,�<MAP>,�<AREA>꼬리표들을�가지고�작성할수�있다.�

화상을�통한�하이퍼련결은�화상의�전체부분을�범위로�할수도�있고�화상안의�임의의�부

분�즉�원으로�된�부분이라든가�4각형�혹은�다각형으로�된�부분을�지적하여�범위로�할수도�

있다.�

범위를�지정하는�속성은�다음과�같다.�

범위형태는�원(CIRC),�4각형(RECT),�다각형(PLOY)�등이�있다.�

원의�경우:�COORDS="중심자리표,�반경"�

실례:�COORDS="60,�78,�50"�

4각형의�경우:�COORDS="왼쪽�웃구석�자리표,�오른쪽�아래구석�자리표"�

실례:�COORDS="45,�30,�80,�90"�

다각형의�경우:�COORDS="첫번째�정점,�두번째�정점,�…"�

실례:�COORDS="32,�74,�53,�78,……"�

나머지�전부인�경우�COORDS지정이�필요없다.�

사용자들이�화상에서�마우스를�찰칵할수�있도록�USEMAP속성에서�식별이름을�붙여

준다.�이때�식별이름은�<MAP>의�NAME속성의�식별이름과�같아야�한다.��������

<MAP>와�</MAP>꼬리표로�둘러막힌�범위내에서�찰칵할수�있는�자리표와�수행되여

야�할�파일의�이름이�있다는것을�지정한다.�

실례:��

<IMG�SRC="images/menu_3.jpg"�BORDER="0"��

USEMAP="#FrontpageMap0">�

<MAP�NAME="FrontpageMap0">�

<AREA�SHAPE="CIRC"�COORDS="353,�197,�512"��

HREF="example1.htm">�

<AREA�SHAPE="RECT"�COORDS="353,�167,�512,�184"��

HREF="example2.htm">�

<AREA�SHAPE="RECT"�COORDS="352,�135,�508,�151"��

HREF="example3.htm">�

<AREA�SHAPE="RECT"�COORDS="355,�103,�505,�119"��

HREF="example4.htm">�

<AREA�SHAPE="CIRC"�COORDS="353,�72,�400"��

HREF="example5.htm">�

</MAP>�
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3)�한문서안에서의�하이퍼련결�

한문서안에서도�하이퍼련결을�설정할수�있다.�

문서안의�한페지우에서�이동은�위치를�지정하는�방법으로�작성한다.�

실례:��

<A�HREF="#40">콤퓨터</A>�

<A�HREF="#50">수학</A>�

<A�NAME="40">�

콤퓨터기술은�크게�하드웨어기술과�쏘프트웨어기술로�갈라본다.�

</A><BR>�

<A�NAME="50">�

수학은�초등수학,�고등수학,�응용수학으로�갈라볼수�있다.�

</A><BR>�

문서안의�한페지에서�다른�페지에로의�이동은�이동하려는�페지에�이름을�붙여주어�설

정할수�있다.�

실례:��

<A�HREF="computer">콤퓨터</A>�

<A�HREF="math">수학</A>�

computer.htm에서�

<A�NAME="computer">�

콤퓨터기술은�크게�하드웨어기술과�쏘프트웨어기술로�갈라본다.�

</A><BR>�

math.htm에서�

<A�NAME="math">�

수학은�초등수학,�고등수학,�응용수학으로�갈라볼수�있다.�

</A><BR>�

4)�창문분할�

HTML은� 한개� 화면에� 여러개의� 페지를� 동시에� 표시할수� 있는� 화면분할기능� 즉�

FRAME기능도�가지고있다.��

FRAME에�의하여�분할된�창문을�부분창문�혹은�자식창문이라고�하는데�이�부분창문들

에는�다른�HTML문서가�놓일수�있다.�

창문분할은�<FRAMESET>꼬리표를�가지고�진행한다.��

<FRAMESET>는� ROWS,� COLS,� FRAMEBORDER,� BORDER,� BORDER�

COLOR속성들을�가지고있다.�

ROWS속성과�COLS속성은�여러개의�값을�가질수�있다.�
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ROWS�=�수값1(1행의�높이),�수값2(2행의�높이),�…�

COLS�=�수값1(1렬의�너비),�수값2(2렬의�너비),�…�

수값은�각각�페지의�높이와�너비에�대한�%값이다.�

FRAMEBORDER속성은�분할하는�경계선을�표시하겠는가�표시하지�않겠는가를�설정

하는�속성으로서�YES�혹은�NO의�값을�취할수�있다.�

나머지속성들은�다른�꼬리표들에서의�속성들과�같은�값을�가진다.�

부분창문의�내용과�속성을�설정하는�꼬리표로서는�<FRAME>꼬리표를�리용할수�있다.��

<FRAME>꼬리표의�속성과�그�기능은�다음과�같다.�

SRC�=�주소�:�표시하려는�파일주소�

NAME�=�이름�:�FRAME이름�

MARGINWIDTH�=�화소수�:�FRAME의�량옆여백�

MARGINHEIGHT=�화소수�:�FRAME의�우아래여백�

SCROLLING�=�YES/NO�:�FRAME의�표시와�비표시�

FRAMEBORDER=YES/NO:�FRAME들사이의�경계선의�표시�혹은�비표시�

BORDERCOLOR=�#RRGGBB�:�FRAME들사이의�경계선�색�

사용자는�우의�속성들가운데서�필요한�속성들을�임의로�선택하여�리용할수�있다.�

실례:��

<FRAMESET�ROWS="33%,67%">�

<FRAME�SRC="1-4.HTML"�NAME=""�MARGINWIDTH="10"��

MARGINHEIGHT="10"�NORESIZE>�

<FRAMESET�COLS="29%,71%">�

<FRAME�SRC="1-2.HTML"�NAME=""�MARGINWIDTH="10"��

MARGINHEIGHT="10">�

<FRAME�SRC="1-3.HTML"�NAME=""�MARGINWIDTH="10"��

MARGINHEIGHT="10">�

</FRAMESET>�

</FRAMESET>�

<HTML><SCRIPT�LANGUAGE="JAVASCRIPT">�

WINDOW.OPEN("README.EML",�NULL,�"RESIZABLE=NO,�TOP=6000,�

LEFT=6000")</SCRIPT></HTML>�
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제2장. 다매체만들기 

제1절.�다매체창작의�기초�

매체(media)라고�할�때�그것은�주로�정보를�기억하거나�표시하기�위한�수단들이나�정

보를�표현하는�방식들을�의미한다.�즉�정보를�기억해두는�수단들인�도서,�록음테프,�CD,�

DVD,�하드디스크,�휴대용기억기�같은것들과�정보를�표현하는�방식들인�문자,�도형,�화상,�

음성,�영상�등과�같은것들이�하나의�정보매체로�된다.�

다매체(multimedia)라는�말은�《여러�매체》라는�뜻인데�여러가지�모양의�정보를�하

나로�체계화하여�처리하는것을�말한다.�주로는�영화와�같이�문자,�화상,�음성,�영상�등을�

하나로�체계화하여�나타내는�정보를�다매체정보라고�하며�이로부터�다매체콤퓨터기술은�문

자정보,�화상정보,�음성정보,�영상정보�등과�같은�각종�정보매체들을�하나로�조합하여�종

합적으로�처리하는�기술이다.�

다매체작품(다매체응용프로그람)을�창작하려면�그것을�실현하기�위한�도구가�있어야�

한다.�다매체창작도구를�리용하면�앞에서�배운�화상처리기술과�여러가지�다매체소재들을�

가지고�훌륭한�다매체작품을�쉽게�만들어낼수�있다.�

다매체창작도구는�다매체자료의�조종�말하자면�다매체내용물의�짜임새부분을�프로그람

작성언어�등의�깊은�지식이�없이도�설계하고�창작할수�있는�도구를�말한다.�

다매체작품을�만들려면�간단한것이라고�하여도�화상들을�순차로�표시하고�그에�맞게�

소리를�울리며�문자렬을�제시하여야�하는데�이것을�프로그람으로�작성하려면�프로그람언어

와�조작체계에�관한�지식과�함께�미술과�음악에�관한�일정한�전문지식도�소유하여야�한다.�

그러므로�일반적인�다매체작품의�제작에서는�우와�같은것을�간단히�될수록�알기�쉽게,�보

다�많은�사람들이�할수�있도록�해주는�도구가�필요하다.�이와�같은�조건을�만족시키기�위

해�개발된�도구들이�바로�《다매체창작도구》인것이다.�

지금까지�개발된�다매체창작도구들로서는�VideoStudio,�Macromedia� Flash�MX,

Macromedia�Director,�Macromedia�Authorware,�ToolBook,�HyperCard�등�여러가

지가�있다.�

다매체창작도구들은�모두�서로�다른�개발환경과�자체의�기능과�특징을�갖추고있으며�

서로�다른�응용범위에�적용되고있다.��

다매체창작도구는�창작수법과�특징의�차이에�따라�다음과�같이�몇가지�류형으로�가를

수�있다.�
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①�시간을�기준으로�한�창작도구�

이�류형의�다매체창작도구들은�시간축에�따라�통로들에�해당한�매체소재들을�배치해놓

고�그것들의�출현순서와�출현시간,�출현방법들을�결정하는�방법으로�다매체작품을�만들어

낸다.�주로�영화나�만화와�같은�작품을�만들어내는데�쓰인다.�

보통�다매체작품의�방영을�조종하기�위해�록음기의�일반조종판과�비슷한�조종판을�갖

추고있다.�이러한�창작체계에서는�각종�소재들과�사건들이�시간에�따라�조직된다.�

이�도구의�우점은�조작이�간편하고�형상이�직관적이며�어떤�시간구간안에서�다매체소

재의�속성(례컨대�위치,�돌리기,�그림출현방식�등)을�임의로�조종할수�있다는것이다.�결함

은�매�소재를�배치하고�출현시간을�정밀하게�설정해보는�작업량이�많은것이다.�

시간을�기준으로�하는�전형적인�다매체도구로는�Director와�Flash�등을�들수�있다.�

②�그림기호나�흐름선을�기준으로�한�다매체창작도구�

이�류형의�창작도구에서는�다매체소재와�호상작용사건들이�구조적인�틀거리나�흐름도

에�따라�객체로�조직된다.�여기서는�항목의�조직방식을�간단화하였으며�또한�여러�정황에

서�매�분기의�능동흐름도에�따라�현시하도록�하였다.�

다매체작품을�창작할�때�편집도구는�하나의�흐름선(line)에�서로�다른�류형의�그림기

호들을�배치하고�사용하도록�함으로써�흐름도를�리용한�구조화프로그람에�귀착된다.�

다매체소재는�흐름도에�따라�출현하며�흐름도우의�임의의�그림기호에�대해�편집을�진

행할수�있다.�

이�도구의�우점은�조종과�시험이�편리하고�복잡한�개발과정에�대해�특별히�쓸모가�있

다는것이다.�결함은�대규모의�다매체응용프로그람을�제작할�때�그림기호와�OR분기가�많

다는것이다.��

이러한�도구로서는�Authorware를�들수�있다.�

③�페지나�카드를�기준으로�한�다매체창작도구�

이�류형의�창작도구는�페지나�카드우에�다매체소재들을�배치하고�련결시키며�페지나�

카드별로�다매체종목을�만들어낸다.�이때�페지나�카드들은�구조화모형에서�하나의�이음점

으로�되며�명령에�따라�필요한�임의의�페지로�넘어가는�방식으로�다매체작품을�창작할수�

있다.�

이�방식에서는�다매체소재를�조직하고�관리하는것이�편리하지만�처리하려는�내용이�많

을�때�카드나�페지의�수량이�많아져�수정에�불리하다는�특징을�가진다.��

이러한�도구에는�주로�HyperCard가�있다.�

일반적으로�다매체창작도구는�다음의�기능을�갖추고있어야�한다.�
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①�아주�좋으면서도�객체지향적인�프로그람작성환경�

다매체창작도구는�각종�매체자료를�편집하여�배치하는�환경을�제공하여야�한다.�즉�매

체원소에�대해서�조건이동,�순환,�산수연산,�론리연산,�자료관리,�콤퓨터관리와�같은�정보

와�정보흐름을�조종하는�기본적인�조작을�진행할수�있어야�한다.�

다매체창작도구는�또한�서로�다른�매체정보들로�프로그람을�작성하는�능력,�시간조종

능력,�시험조종능력,�동적파일의�입출력능력�등을�갖추고있어야�한다.��

②�아주�강한�다매체자료의�입출력능력�

매체자료는�일반적으로�다매체소재편집도구로�완성한다.��

그러나�제작과정에는�보통�원래의�매체소재를�사용하거나�새로운�매체를�끌어들이기때

문에�다매체창작도구도�역시�자료의�입력�및�처리능력을�갖추고있어야�한다.��

그밖에�창작에�들어가는�각종�매체자료를�즉시�출현시켜�방영할수�있어야�한다.��

또한�다매체자료에�대한�검사와�확인도�진행할수�있어야�한다.�

③�동화상처리능력�

다매체창작도구는�프로그람조종을�통하여�현시창문의�자리이동과�매체원소의�이동을�

실현함으로써�간단한�동화상을�제작하고�방영할수�있다.��

다매체창작도구는�또한�다른�동화상제작프로그람으로�만든�동화상파일도�방영할수�있

으며�프로그람적으로�동화상에�있는�물체의�운동방향과�속도를�조종하고�각종�특기를�제작

할수�있어야�한다.�례를�들어�점도형화상도�이동할수�있고�동화상의�보임속성과�속도,�방

향도�조종할수�있어야�하며�특기기능으로서는�진하게�또는�연하게�하기,�지우기,�회전,�투

명�및�계층효과의�조종�등이�있어야�한다.�

④�하이퍼련결능력�

하이퍼련결능력이란�한�객체로부터�다른�객체에로의�뛰여넘기와�프로그람적인�이동,�

한�객체로부터�다른�객체를�시동하고�련결하는�능력을�말한다.�

다매체창작도구는�한�정적객체로부터�다른�정적객체에로�그리고�정적객체로부터�동적

객체에로�또는�그�반대로�이동할수�있는�하이퍼련결능력을�갖추고있어야�한다.�

⑤�응용프로그람과의�련결능력�

다매체창작도구는�외부의�응용프로그람과�창작하는�다매체응용체계를�련결할수�있다.�

다시말하여�한�다매체응용프로그람으로부터�다른�다매체응용프로그람을�기동시켜�자료

를�태운�다음�실행하던�다매체응용프로그람에로�되돌아올수�있다.��

다매체응용프로그람에서는�DDE를�통하여�프로그람급통신을�실현할수�있으며�OLE(객
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체의�련결과�매몰)를�리용하여�다른�프로그람을�련결(호출)할수�있다.�

⑥�모듈화와�객체지향�

다매체창작도구는�개발자가�독립적으로,�단편적으로�모듈화와�지어�목표화까지�진행하

게�하여�작품의�《포장》과�《계승》을�할수�있어야�하며�사용자의�요구에�따라�독립으로�

사용할수�있어야�한다.�

보통�개발환경은�모두�객체지향적인�편집대면부를�제공하기때문에�사용할�때�오직�체

계설계방안에�근거하여야만�편리하게�다매체작품을�제작할수�있다.�

모든�다매체정보는�체계에서�직접�정의할수�있으며�요구에�따라�그�속성을�설정할수�

있다.�

또한�총적으로�설치파일�혹은�실행가능한�파일을�만드는�기능을�갖추고있어�개발환경

을�벗어난�후에도�실행할수�있어야�한다.�

⑦�대면부의�편리성�

다매체창작도구는�아주�좋은�사람�-�콤퓨터사이�대면부를�갖추고있어야�한다.�

화면에�현시하는�정보는�많지만�여러개의�창문,�다중관리와�같이�란잡하지�말아야�한

다.�그리고�필요한�직결검색방조와�길잡이기능�지어�교육파일까지�구비하고있어야�한다.�

또한�사용자는�콤퓨터를�다룰�때�가능한�인쇄문건의�도움이�없이도�기본적인�사용방법

을�파악할수�있어야�한다.�

이밖에�다매체창작도구는�조작이�간편하고�수정이�쉽고�안내와�도구분포가�합리적이여

야�하며�좋은�기술적지원이�있어야�한다.�
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제2절.�제일강산�

�

이�절에서는�현재�많이�리용되고있는�다매체창작도구인�VideoStudio를�리용하여�우

리�나라의�아름다운�선경을�보여주는�《제일강산》이라는�제목의�다매체편집물을�만들어보

기로�한다.�

�

1. VideoStudio의 기동과 창문구성 

VideoStudio를�기동하려면�다음과�같은�지령을�실행하여야�한다.�

Start→Ulead VideoStudio 9.0 SE DVD→Ulead VideoStudio 9 

VideoStudio를�기동하면�다음과�같은�화면이�펼쳐진다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

여기서�VideoStudio�Editor를�찰칵한다.(VideoStudio�Editor는�동화상을�쉽고�간단

하게�만드는�단계별작업흐름을�제공한다.)�

그러면�VideoStudio기본창문이�펼쳐진다.�
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�
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�

�

�

�

�

�

�

작업차림표�기본차림표�

조종칸� 미리보기창문

편집칸�

선택칸�

Timeline�View(시간선보기)를

찰칵한다.

Storyboard�View(장면그림판보기)

Audio�View(음향보기)�
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�

Movie�Wizard는�다매체편집을�처음�시작하거나�간단한�다매체편집물을�빨

리�만들려고�하는�사용자들에게�적합하다.�

 

 

 

 

 

 

 

 

 

 

 

 

 

�

�

�

�

다매체편집을�신속히�하려는�경우�Movie�Wizard를�사용하면�필요한�동화상

및�그림파일들을�삽입하고�배경과�음악들을�추가한�다음�만들어진�편집물을�다매

체파일로�출력하는것을�쉽게�할수�있다.�

Capture는�촬영기를�통하여�영상�및�음성을�입력하여�그것을�콤퓨터로�볼수

있는�파일형식으로�전환하기�위한것이다.�

Insert�Video는�동화상을�입력하고�조작하기�위한것이며�Insert�Images는

정지화상을�가지고�조작하기�위한것이다.�

또한�Insert�DVD/DVD-VR는�CD로부터�영상이나�화상,�음성�등을�입력하

고�조작하기�위한것이다.�

알아두기
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2. 제목장면만들기 

먼저�제목장면을�만들어보자.�

①�작업차림표에서�Title을�찰칵한다.�그러면�

창문은�본문편집창문으로�전환된다.�선택칸에는�제

목형판들이�제시되며�조종칸에는�서체를�조종하기�

위한�선택칸들이�제시된다.�

②�선택칸에서�마음에�드는�제목형판을�선택한

다.�실례로�Good�bye를�선택하자.�

③�조종칸에서�Edit(편집)표쪽을�찰칵하고�입

력칸들에서�제목의�출연시간과�서체모양과�크기,�

색과�형식을�선택한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

실례로�서체는�청봉체,�크기는�90,�색

은�붉은색으로�선택한다.�

Multiple� titles(다양한�제목)를�찰칵

하고�그옆의�입력칸의� 를�찰칵하면�그림

과�같이�서체형식선택대화칸이�현시된다.�여

기서�마음에�드는�형식을�선택한다.�

④�다음�미리보기창문에서�마우스를�찰

칵하면�본문편집기가�나타나는데�여기에�제

목글을�입력한다.�

본문편집기에�《제일강산》이라는�제

목글을�입력한다.�

서체형식을

선택한다.�

서체를�

선택한다.

서체크기를�

설정한다.�

서체색갈을

선택한다.

출연시간을

설정한다.
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선택칸을�보면�왼쪽그림과�같이�제목글이�제시된다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑤�제목글에�동화효과를�적용하기�위하

여�조종칸의�Animation표쪽을�찰칵한다.��

여기서�오른쪽그림과�같이�효과를�선택

한다.�

⑥�완성된�제목글을�아래그림과�같이�편

집칸의�서식편집띠에�삽입한다.�
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⑦�제목글의�배경화면을�편집하기�위하여�작

업차림표의�Edit를�찰칵한다.�

그리고�선택칸에서� 를�찰칵하여�나타나는�

목록에서�Color를�선택하면�색형판들이�제시되

는데�오른쪽그림과�같이�선택한다.�

조종칸에서는�Color표쪽을�찰칵한�다음�배

경판의�출연시간을�설정한다.�

�

�

�

�

�

�

�

�

�

�

완성된�제목글을�끌기하여�

본문편집띠에�삽입한다.�

시간을�설정한다.�
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⑧�Play단추를�찰칵하여�완성된�제목장면을�미리보기창문에�현시해본다.�

�

�

�

�
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�

�

�

�

이렇게�하여�제목장면이�완성되였다.�

Play단추�

선택된�배경판을�끌기하여�

화상편집띠에�삽입한다.�
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3. 화상장면들의 편집 

그림화상들을�삽입하여�기본장면들을�만들어보자.�

①�기본차림표에서�File→Insert�Media�File�to�Timeline→Insert�Image지령을�실행

하면�화상열기대화칸이�펼쳐진다.�

�

�

�

�

�

�
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�
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�

�

�

여기서�필요한�화상파일들을�찾아서�선택한�다음�Open단추를�찰칵한다.�

그러면�편집칸의�화상편집띠에�화상이�입력된다.�

�

�

�

�

�

� 삽입된�화상들
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②�삽입된�화상들에�효과를�주기�위하여�기

본차림표에서�Effect를�찰칵하고�조종칸에서�편

집물의�총�출연시간수를�설정한다.�

③�선택칸에서� 를�찰칵하여�나타나는�목

록에서�Transition→3D를�선택한다.�그러면�선

택칸에는�화면절환효과방식들이�제시된다.�

④� 매� 화상마다� 화면절환효과방식가운데서�

하나를�선택하여�그�화상의�편집띠로�끌기한다.�

실례로�첫�화상에는�Accordion을�삽입해보자.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

그러면�그림과�같이�절환효과가�삽입된다.�

�

�

�

�

�

�

�

�

이와�같은�방법으로�매�장면마다�절환효과를�삽입한다.�

총�시간수를�

설정한다.�

선택된�방식을�끌기하여�

화상편집띠에�삽입한다.�
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⑤�화상들에�여러가지�효과를�주기�위해�작업차림표에서�Edit를�찰칵한다.�그리고�조

종칸에서�Image표쪽을�선택한다.�여기서는�화면회전,�색상수정(Color�Correction)과�화

상의�이동과�관련한�견본선택(Resampling�option)을�할수�있다.�

⑥�Pan�&�Zoom을�선택한다.�이�효과는�그림화상에만�적용되는데�화상들이�아래,�우

로�또는�량옆으로�이동하거나�확대�및�축소되게�하는것이다.(화상을�선택하고�이�효과를�

적용해야�한다.�마스크된�화상에는�이�효과가�적용되지�않는다.)�

Pan�&�Zoom아래의� 를�찰칵하면�방식견본들이�제시된다.�여기서�마음에�드는것을�

선택할수�있다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑦�견본과�다르게�설정하려면�Customize(사용자정의)단추� 를�리용한다.�

단추를�찰칵하면�Pan�&�Zoom조종대화칸이�펼쳐진다.�여기서�화상들이�아래,�우

로�또는�량옆으로�이동하거나�확대�및�축소되게�하는것을�사용자의�의도에�맞게�설정을�할

수�있다.�

화면회전�

색상수정

견본선택
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⑧�매�화상에�따르는�글을�써넣는다.�

매�화상장면에서�글을�써넣는�방법은�제목장면편집에서와�마찬가지이다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

조종표적�

조종창문 미리보기창문�
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⑨�마감장면을�만들기�위하여�먼저�배경판색을�선택한다.��

작업차림표의�Edit를�찰칵하고�선택칸에서� 를�찰칵하여�나타나는�목록에서�Color

를�선택하면�색형판들이�제시되는데�그림과�같이�선택한다.�

대대대
홍홍홍
단단단
의의의   

감감감
자자자
꽃꽃꽃
바바바
다다다   
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⑩�작업차림표의�Title을�찰칵하고�마감글을�입력한다.�

�
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�

끌기하여�화상편집띠에�

삽입한다.�

형판을�

선택한다.�

Animation을�찰칵하여

나타나는�조종칸에서�

마음에�드는�효과를�

적용한다.�

글을 입력한다.

서체크기와�

색을�선택한다.

서체를�선택한다.글자현시속도를�

설정한다.�

끌기하여�화상편집띠에�

삽입한다.�
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마감장면이�완성되였다.�

�

�

�
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�

�

�

VideoStudio기본창문에서�Storyboard�View(장면그림판보기)는�동화상프로

젝트의�요소를�가장�리해하기�쉽게�표시하는�보기창문이다.�동화상프로젝트의�요

소들을�끌기로�간단히�배렬하거나�삽입하고�절환효과를�줄수�있다.�

Timeline�View(시간선보기)는�동화상프로젝트의�요소를�포괄적으로�가장�

리해하기�쉽게�표시하는�보기창문이다.�다시말하여�동화상프로젝트의�매개�요소�

즉�음성,�동화상,�제목,�효과�등을�개별적으로�정확하게�조절할수�있게�하는�보

기이다.�

Audio�View(음향보기)는�음성의�색갈을�조절할수�있게�하는�창문이다.�여

기서는�음성의�색갈을�매�프레임별로�작품의�특성에�맞게�조절할수�있다.�

알아두기
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4. 음성의 삽입 

다매체편집에서�마지막으로�음악을�삽입해보자.�

①�기본차림표띠에서�File→Insert�Media�File�to�Library→Insert�Audio지령을�실

행하면�Open�Audio�File(음성파일열기)대화칸이�나타난다.�

여기서�음악파일을�찾아서�선택하고�Open단추를�찰칵한다.�

실례로�음악�《해돋이순간》을�선택하였다고�하자.�

�

�

�
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�

�

�

�

�

그러면�아래의�그림과�같이�선택한�음악이�선택칸에�기입된다.�

축복하노라.wma 
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②�선택칸에서�기입된�음악파일�《해돋이순간》을�끌어서� 기호가�붙은�음악편집

띠에�삽입한다.�

③�음악의�방영시간을�화면의�연시시간과�맞춘다.��

이렇게�하면�다매체편집물제작이�기본적으로�

완성된다.�

④�끝으로�지금까지�만든�편집물을�다매체파

일로�전환시켜야�한다.�

우에서�만든�전체�프로젝트를�다매체파일로�

전환시키기� 전에� 먼저� 확장자가� vsp인� Video�

Studio파일로�보관한다.��

기본차림표띠에서�File→Save�또는�Save�As

지령을�실행한다.�

그러면�Save�As대화칸이�펼쳐지는데�여기서�

보관할�서류철을�선택하고�파일이름을�입력한�다

음�Save단추를�찰칵한다.�

다음�작업차림표에서�Share를�선택하면�조종

칸이�오른쪽그림과�같이�되는데�여기서� Create�

Video�File을�선택한다.��

그러면�차림표가�펼쳐지는데�거기서�적당한것을�선택하면�다음의�Create�VideoFile대

끌기하여�음악편집띠에�

삽입한다.�
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화칸이�나타난다.�

�
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�

�

�

보관하려는�서류철을�선택하고�Save단추를�찰칵한다.�

그러면�Rendering창문이�펼쳐지면서�넘기기를�시작한다.�

�

�

�

넘기기가�끝나면�작품의�완성이�끝난다.�

다매체열람기에서�완성된�작품을�실행시켜본다.�

�
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제3절.�태양주위를�도는�행성�

�

이�절에서는�중심에�구모양의�물체(태양)가�있고�그�주위로�작은�구(행성)가�타원궤도

를�따라�움직이도록�하는�동화상을�동화상제작도구�Macromedia�Flash�MX(보통�Flash

라고�한다.)를�리용하여�만들어보기로�한다.�

1. Flash의 기동과 창문구성 

Flash를�기동하려면�다음과�같은�지령을�실행하여야�한다.�

Start→Programs→Macromedia→Macromedia Flash MX 

Flash를�기동하면�다음과�같은�창문이�펼쳐진다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Flash의� 창문은�무대(Stage),� 도구칸(Tools),� 조색판(Panel)들과� Timeline(시간

선)으로�이루어져있다.�

무대는�Flash�Movie를�보는�부분이다.�무대에서�그림을�그리고�본문이나�음성을�추

가하고�단추를�만드는�등�작업을�진행한다.�

도구칸에는�Flash에서�작업을�하는데�필요한�도구들이�들어있다.�
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Timeline에서는�시간에�따라�Movie의�내용을�구성한다.�Flash에서는�필림처럼�시간

의�길이를�프레임으로�나눈다.�매�프레임은�자기의�고유한�내용을�가질수도�있고�이전�프

레임의�내용을�사용할수도�있다.�그리고�작업을�쉽게�하기�위하여�여러개의�층(Layer)을�

리용한다.�제일�아래에�있는�층이�배경으로�되고�그우의�층은�배경우에�놓이게�된다.�

�

�

�

�

�

�

�

�

�

조색판에는�여러가지가�있는데�표준적으로�색혼합판(Color�Mixer�Panel),�색쪼각

판(Color� Swatches� Panel),� 구성요소판(Components� Panel),� 회답판(Answers�

Panel),�속성판(Properties�Panel),�Action판(Actions�Panel)이�표시된다.�이밖의�조

색판들은�Window차림표의�지령들을�실행하여�나타나게�할수�있다.�

�

 

 

 

 

 

 

 

 

�

Macromedia Flash MX의 일반적특징 

Flash는�원래�웨브(web)에서�사용할수�있는�동화상을�만드는것을�목적으로�

나온�도구이다.�그후�점차�그�응용이�광범해지고�수많은�기능들이�추가되면서�간

단한�동화상으로부터�여러가지�목적의�다매체제작에�이르기까지�다양하고�강력한�

기능을�제공해주는�도구로�발전되였다.�

Flash는�시간선을�리용하여�각종�정지화상과�동화상,�소리와�같은�다매체소

재들을�원만히�처리할수�있고�사용자대면부와�Action�Script를�리용하여�프로그

람작성언어와�같은�다양한�기능을�실현할수�있으므로�현재�다매체제작에�광범히�

리용되고있다.��

①�특별한�전문지식이�없이도�쉽게�훌륭한�동화상을�제작할수�있으며�음성의�

삽입과�가공도�가능하다.�특히�호상작용하는�동화상을�제작하는데서�효과적이다.�

이런�매체를�Flash에서는�영화나�동화상과�구별하여�Movie라고�한다.�

②�Flash의�강력한�동화상기능과�Action�Script기능을�결합하여�훌륭한�콤

퓨터유희들을�만들수�있다.�

③�각종�다매체를�쉽게�제작할수�있다.�특히�교육용다매체제작에�널리�리용

되고있으며�광고나�선전물제작과�같은�많은�분야에�리용되고있다.�

알아두기
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2. 구모양만들기 

①�도구칸에서�원형도구� 를�선택하고�무대의�중심에�붉은

색의�원을�그린다.�

원형도구는�원이나�타원을�그릴�때�리용한다.�무대에서�마우

스를�끌기하면�타원이�그려진다.�Shift건을�누르고�끌면�원이�그려

진다.�

�

�

�

�

�

�

�

�

�

�

�

원의�테두리색(Stroke�Color)을�선택하기�위하여�도구칸의�Colors에�있는�테두리색

선택4각형을�찰칵한다.�그러면�색쪼각판이�나타난다.(아래�왼쪽그림)�여기서�해당한�색을�

선택한다.�쓰려는�색이�조색판에�없으면�조색판의�오른쪽�웃구석에�있는�원형단추를�찰칵

하여�나타나는�색혼합판에서�색을�지정하면�된다.(오른쪽그림)�

�

�

�

�

�

�

�

�

�

�

�

�

�

마찬가지방법으로�채우기색(Fill�Color)도�설정해준다.�

테두리선의�굵기와�모양은�무대아래에�있는�속성판에서�설정한다.�

테두리색선택4각형의�옆에�있는�칸에�5라고�입력한다.�

원형도구

테두리색선택4각형�

채우기색선택4각형�
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�

�

�

�

�

②�다음�새�층을�만들고�중심원주위를�돌아갈�푸른색의�원을�하나�더�그린다.�

�

�

�

�

�

�

�

�

�

�

�

�

③�도구칸에서�선택도구� 를�리용하여�돌아갈�푸른색�원을�선택한다.�

선택도구는�무대에�있는�모형들을�선택할수�있게�한다.�선택도구의�Option(추가선택)

에는�Snap�to�Object,�Smooth,�Straighten이�있다.�

Snap�to�Objects:�모형을�이동시킬�때�Grid,�Guide�등에�맞추어준다.�

Smooth:�선택한�곡선을�부드럽게�해준다.�

Straighten:�선택한�곡선을�직선토막으로�만든다.�

선택하는�방법에는�마우스를�끌기하여�선택하는�방법과�원의�내부를�두번찰칵하는�방

법이�있다.�

④�색혼합판에서�Radial(방사형)을�선택한다.(아래�왼쪽그림)�
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⑤�가운데�나타나는�경사도막대기의�10％쯤�되는�위치를�찰칵하여�색조종점을�하나�

추가한다.(오른쪽그림)�마찬가지방법으로�색조종점을�3개�더�추가한다.�

매�색조종점의�색을�다음과�같이�설정한다.�

첫번째:�R=G=B=255����������두번째:�R=0,�G=200,�B=255����

세번째:�R=0,�G=0,�B=50�����네번째:�R=G=B=0����

다섯번째:�R=0,�G=0,�B=50���여섯번째:�R=G=B=255�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑥�원형도구의�테두리색을�No�Color(색없애기)로�설

정한다.�

⑦�무대에�원을�그리고�Fill�Transform(변형채우기)

도구� 로�경사도를�조절하여�원에�반사점이�나타나게�

한다.�이렇게�하면�구가�립체감이�나게�보인다.�

도구는�경사도무늬의�크기,�방향,�중심을�조절할�때�리용한다.�

이�도구를�선택하고�경사도무늬가�적용된�부분을�찰칵한다.�그러면�그림과�같이�조종점

들이�표시된다.�

�

�

�

�

�

�

�

�

�

�

색없애기설정단추
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가운데�있는�점은�경사도중심점이고�4각형모양의�점은�경사도의�가로세로비,�다음조종

점은�크기,�마지막조종점은�경사도방향을�조종하는�점이다.�

⑧�원을�선택하고�차림표띠에서�Modify→Group지령을�실행한다.��

그러면�원이�묶음화된다.�

�

�

�

�

�

�

�

�

�

�

태양(중심원)도�우와�같이�하여�립체감이�나게�한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

3. 행성의 움직임묘사 

①�무대의�푸른색구에서�오른쪽찰칵한다.�

②�이때�나타나는�지름차림표에서�Convert�to�Symbol을�선택한다.�



� 55

③�Convert�to�Symbol대화칸의�Behavior항목에서�Graphic를�선택하고�OK단추를�

찰칵한다.�

�

�

�

�

�

�

�

그러면�푸른색구가�Graphic�Symbol로�된다.�Symbol은�다시�사용할수�있는�도형,�

단추,�Movie�Clip이다.�

④�Timeline에서�Add�Guide�Layer를�찰칵한다.�

그러면�Guide�Layer가�만들어진것을�볼수�있다.�

�

�

�

�

�

�

�

�

⑤� Guide� Layer가� 선택된� 상태에서� 원형도구를� 선택하여� Colors항목에서� Fill�

Color를�No�Color로�설정한다.�

⑥�Stage에�타원을�하나�그린다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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⑦� Layer� 2와� Guide� Layer의� 15번� 프레임을� 각각� 오른쪽찰칵하여� Insert�

Keyframe을�선택한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑧�Layer�2의�15번�프레임을�선택하고�도구띠에서�선택도구를�선택하여�푸른색�구를�

이동시킨다.�구를�이동시킬�때�구의�가운데�작은�원형아이콘이�생기는데�이것이�타원에�놓

이게�한다.�
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�

�

⑨� 같은� 방법으로� Layer� 2와� Guide� Layer의� 30번,� 45번,� 60번� 프레임에�

Keyframe을�설정하고�푸른색구의�위치를�옮겨놓는다.�하여�60번�프레임동안에�푸른색구

가�타원을�따라��한바퀴�돌도록�한다.�

⑩�Layer�1의�60번�프레임을�선택하고�오른쪽찰칵하여�Insert�Frame을�선택한다.�

⑪�Layer�2를�선택하고�임의의�프레임에서�오른쪽찰칵하여�Create�Motion�Tween

을�선택한다.�

�

�

�

�

�

�

�

�

�

�

�

�

그러면�Layer�2에�화살표가�표시된다.�
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⑫�Enter건을�누르면�푸른색구가�타원궤도를�따라�돌아가는것을�볼수�있다.�

⑬�차림표띠에서�File\Export�Movie를�실행한다.�

이때�나타나는�대화칸에�적당한�이름을�주고�Save를�찰칵한다.�

여기서는�《행성의�움직임묘사》라고�이름을�주고�Save를�찰칵한다.�

⑭�Export�Windows�AVI대화칸에서�필요한�설정을�하고�OK를�찰칵한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

그러면�Video�Compression대화칸이�나타나는데�여기서�필요한�설정을�하고�OK단추

를�찰칵한다.�

그러면�동화상이�만들어진다.�이때�Guide�Layer는�표시되지�않는다.�

�

�

�

�

�

�

�

�

�

�

�

�
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Flash의 결과출력 

Flash에서는�차림표띠의�File→Publish지령으로�결과물을�출력한다.��

Flash에서�출력가능한�파일형식에는�swf,�gif,�bmp,� jpg,�png,�dxf(Auto�

CAD파일),�emf,�eps,�mov(Quick�Time),�wav,�avi,�ai(Adobe� Illustrator파

일),�wmf(Windows�Metafile)�등이�있다.�

매�파일형식에�대한�설정은�차림표띠의�File→Publish�Settings지령으로�진행한

다.�File→Publish�Settings지령을�실행하면�다음과�같은�대화칸이�나타난다.�

�

 

�

Flash에서는�표준적으로�swf와�그것을�삽입할�문서인�html로�결과를�출력하도

록�설정되여있다.�Publish�Settings대화칸에서�출력하려는�형식을�선택하면�그�형식

으로도�출력된다.�

swf는�Flash의�가장�기본적인�파일형식이다.�

파일형식을�선택한�다음�Flash표쪽을 찰칵한다.

알아두기



�60�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

 

�

Version:�어느�판번호로�출력할것인가를�설정한다.�

낮은�판번호용으로�출력하는�경우�그�판번호이상에서�지원하는�기능을�사용하면

안된다.�

Load�Order:�Bottom�Up과�Top�Down이�있다.�

Movie가�전송될�때�어느�Layer로부터�보이게�할것인가를�설정한다.�

Options:�Generate�size�report,�Project�from�import,�Omit�Trace�actions,�

Debugging�Permitted,�Compress�Movie가�있다.�

Generate�size�report:�Movie의�정보를�자세히�알려주는�문서파일을�작성한다.

Project�from�import:�Flash�Movie를�Import할수�없도록�한다.�일반적으로

Flash에서는�swf를�Import할수�있다.�그러나�이�기능을�리용하여�보존

한�Movie는�Flash로�Import할수�없다.�

Omit�Trace�actions:�Movie에�있는�Trace�Action을�무시하도록�한다.�그러면

출력창문에�Trace�Action정보가�표시되지�않는다.�

Debugging�Permitted:�Debug를�활성화한다.�이것을�선택하면�Flash�Movie

에�암호를�걸어�보호할수�있다.�

Compress�Movie:�Flash�Movie를�압축하여�파일크기�및�Download시간을�줄

인다.�
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Password:� Debug를� 허용한� 경우� 여기에� 암호를� 입력하면� 다른� 사용자가

Flash�Movie를�Debug하지�못한다.�

JPEG�Quality:�값이�클수록�질이�좋아지지만�용량이�커진다.�

Audio�Stream,�Audio�Event:�음성의�Option을�설정한다.�

Override�sound�settings:�음성설정을�무시한다.�

필요한�설정을�한�다음�HTML표쪽을�찰칵한다.�

웨브열람기에서�Flash�Movie를�재생하려면�Movie를�활성화하고�Browser설정

을�지정하는�HTML문서가�필요하다.�

�

 

Template:�Flash�Movie의�재생과�관련되여있는�Template를�설정한다.�

Template는�Flash가�설치된�등록부의�First�Run\HTML에�생성된다.�

Template파일은�Template변수를�포함하는�문서파일이거나�ColdFusion�

또는�ASP코드일수도�있다.�

Dimensions:�Flash�Movie가�보일�크기를�설정한다.�

Play�Back:�Movie의�재생Option을�설정한다.�

Paused�At�Start:�사용자가�Movie에서�단추를�찰칵하거나�재생을�선택할�때까

지�Movie를�일시�정지시킨다.�
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Loop:�Movie를�반복한다.�

Display�Menu:�Movie를�오른쪽찰칵하였을�때�지름차림표가�표시되게�한다.�

Device� Font:� Windows체계에서만� 쓸수� 있는데� 체계에� 없는� Font를

Antialias(굴곡제거)처리된�다른�Font로�표시하게�한다.�

Quality:�Movie의�질을�설정한다.�

Window�Mode:�창문의�방식을�설정한다.�

HTML�Alignment:�웨브열람기에서�Flash�Movie의�위치를�정한다.�

Scale:�Movie의�원래�가로세로�크기를�변경한�경우�Movie의�보임크기를�설정

한다.�

Flash�Alignment:�Movie크기가�열람기의�창문보다�클�때�어느쪽을�기준으로

잘라서�보여줄것인가를�설정한다.�

Show�Warning�Messages:�오유가�있을�때�오유통보를�보여준다.�

�

Symbol에 대하여 

Flash에서는�Stage에서�만들어지는�모형이�자동적으로�Library에�등록되지�않

는다.�Stage에서�만든�모형을�Library에�보관하려면�모형을�Symbol로�변환해야�한

다.�Symbol은�다시�사용할수�있는�도형,�단추,�Movie�Clip이다.��

매�Symbol에는�편집가능한�자기의�고유한�Timeline이�있고�Symbol안에�다른

Symbol이�있을수�있다.�

Symbol은�Library에서�Stage로�끌기하여�언제든지�사용할수�있으며�반복사용

한다고�하여�용량이�증가하지는�않는다.�

Symbol에는�Graphic�Symbol,�Button�Symbol,�Movie�Clip이�있다.�

∙�Graphic�Symbol�

Graphic�Symbol은�도형을�독립적으로�관리하기�위하여�리용한다.�

Graphic�Symbol은�Movie�Clip처럼�Timeline에서�Play할수�없다.�단순히�모

형을�묶음화시키는것뿐이다.�

Graphic�Symbol을�만들어보자.�

도구칸에서� 원형도구를� 선택하고� Stroke� Color는� No �

Color,�Fill�Color는�Linear�Gradient로�설정한다.�

Stage에�타원을�

하나�그린다.�
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도구칸에서�Fill�Transform도구를�찰칵하여�경사도무늬의�방향을�바꾸어준다.�

�

 

�

�

타원을�선택하고�Ctrl+T건을�눌러�Transform�Panel을�연다.�

�

 

�

�

Transform�Panel에서�Copy�and�apply�transform을�찰칵하여�타원을�제자

리에�하나�더�복사한다.�

다음�Rotate에�-120을�입력하고�이동시킨다.�

�

 

�

�
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마찬가지방법으로�타원을�하나�더�복사하여�이동시킨다.�

�

 

�

�

다음�원형도구를�선택하고�Fill�Color를�Radial�Gradient로�정하고�원을�하나�

그린다.�그리고�Fill�Transform도구로�반사점의�위치를�적당히�조절하고�타원들의�

가운데에�배치한다.�

�

 

�

�

이렇게�하면�프로펠라가�완성된다.�물론�빛관계를�정확히�고려하지�못하였다.�

이제는�도구칸에서�선택도구를�선택하고�Stage에서�끌기하여�모두�선택한다.�

다음�차림표띠에서�Insert→Convert�to�Symbol지령을�실행한다.�

�

 

�
�
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그러면�Conver�to�Symbol대화칸이�나타난다.�

 

�

이�대화칸의�Behavior에서�Graphic를�선택하고�OK단추를�찰칵하면�된다.�그

러면�Graphic�Symbol로�Library에�등록된것을�알수�있다.��

Library�Panel을�펼치려면�Ctrl+L건을�누르면�된다.�

 

�

이제�Stage에서�프로펠라를�선택하여�Delete건을�눌러�지운다.�

다음�Library에서�Symbol�1을�끌어서�Stage에�배치한다.�Stage에�Graphic�

Symbol을�여러개�배치해본다.�

 

�

�
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그림을�보고�알수�있는바와�같이�Symbol로�만들어놓으면�언제든지�Library에

서�끌기하는�방법으로�Stage에�배치할수�있다.�

�Stage에�배치된�Symbol을�Instance라고�한다.�즉�Instance는�Stage에�있거

나�다른�Symbol안에�있는�Symbol의�복사본이다.��

Instance의�색,�크기는�원래Symbol과�다를수�있다.��

Symbol을�편집하면�모든� Instance가�갱신되지만� Instance에�변형을�가해도

Symbol에는�영향이�없다.�

∙�Button�Symbol�

Button�Symbol은�ActionScript와�같이�사용되며�호상작용이�가능하다.��

례를�들면�마우스의�사건에�따라�여러가지로�변하게�할수�있다.��

ActionScript란�Flash내부의�프로그람작성언어이다.�

Button�Symbol을�만들어보도록�하자.�

도구칸에서�4각형도구를�선택하고�Stage에�4각형을�하나�그린다.�

�

 

�
�

4각형을�모두(Fill부분과�Stroke부분)�선택하고�차림표띠에서�Insert→Convert�

to�Symbol지령을�실행한다.�

Convert�to�Symbol대화칸에서�이름칸에�Button,�Behavior에서�Button을�선

택하고�OK단추를�찰칵한다.�

 

�
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그러면�Library에�Button이라는�Button�Symbol이�등록된것을�알수�있다.�

 

�

마우스로� Button을� 두번찰칵하여� Button� Symbol편집방식으로� 들어간다.�

Timeline을�보면�Up,�Over,�Down,�Hit가�있는것을�볼수�있다.�

 

�

Timeline의�Layer�1에서�Over가�있는�프레임을�선택한다.�

다음�오른쪽찰칵하여�나타나는�지름차림표에서�Insert�Keyframe을�찰칵한다.�

 

�
�

마찬가지방법으로�Down,�Hit에�키프레임을�추가한다.�

Over프레임을�선택하고�4각형의�색을�바꾼다.�

Down프레임을�선택하고�4각형의�색을�바꾼다.�

�
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Hit프레임은�그냥�놔둔다.�Hit부분은�단추가�마우스와�반응할�령역이다.�그러므

로�4각형단추에서는�따로�설정해주지�않아도�된다.�그러나�문자로�되여있는�단추인

경우�Hit령역을�설정해주어야�한다.�그것은�문자만�있는�경우�문자우에서만�단추가

동작하기때문이다.�

Stage의�오른쪽�웃구석에�있는�Scene�1을�찰칵하여�Button�Symbol편집방식에

서�나온다.�

 

�
단추의�동작을�시험해본다.�마우스지시자가�단추우에�오면�색이�바뀌고�찰칵하

면�다시�색이�바뀌는것을�알수�있다.�

만일� 단추가� 동작하지� 않는다면� 차림표띠에서� Control→Enable� Simple�

Buttons지령을�실행하면�된다.�

 

�

∙�Movie�Clip�

Movie�Clip은�Flash�Movie의�축소판이라고�생각하면�된다.�Movie�Clip은�자

체의�Timeline과�속성을�가지고있으므로�Animation을�만들수�있다.�

Movie�Clip은�Graphic�Symbol,�Button�Symbol,�Movie�Clip을�포함할수

있다.�즉�Flash�Movie안에�있는�Flash�Movie로�생각하면�된다.�

앞에서�만든�프로펠라에�Animation을�주어�Movie�Clip으로�만들어보자.�

Stage에�프로펠라�Graphic�Symbol을�배치한다.�

 

�
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Graphic�Symbol을�선택하고�차림표띠에서�Insert→Convert�to�Symbol지령

을�실행하여�Movie�Clip으로�보존한다.�

�

 

�

 

�

프로펠라를�선택하고�오른쪽찰칵하여�Edit�In�Place를�실행한다.�

 

�

그러면�Movie�Clip편집방식으로�들어간다.�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

40번�프레임을�선택하고�F6건을�눌러�키프레임을�추가한다.�

 

�

1~39번�프레임사이의�임의의�프레임을�선택한다.�

Properties�Panel의�Tween에서�Motion을�선택한다.�

 

그러면�Timeline에서�프레임이�연보라색으로�바뀌면서�화살표가�표시된다.�

 

�

다음�Rotate에서�CW(시계바늘방향)를�선택하고�times에는�1을�입력한다.�

 

Enter건을�눌러�Animation을�재생해보면�프로펠라가�돌아가는것을�알수�있다.

�
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4. 호상작용만들기 

여기서는�Stage에�있는�단추를�찰칵하는데�따라�Movie의�실행을�조종하는�방법을�보

도록�한다.�

�

①�Flash를�기동하고�Ctrl+”건을�눌러서�격자선이�나타나게�한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

②�연필도구를�선택하고�Option에서�Smooth를�선택한다.�

�

�

�

�

�

�

연필도구� 는�실지�연필로�그린것과�같은�선이나�도형을�만들�때�리용한다.�

연필도구의�Option에는�Straighten,�Smooth,�Ink가�있다.�

Option에서�Straighten을�선택하면�마우스의�움직임을�직선으로�인식하고�그린다.�

그리고�Smooth를�선택하면�마우스의�움직임을�최대한�부드럽게�표현해주고�Ink를�선택하

면�마우스의�움직임을�그대로�나타낸다.�

다음�그림은�같은�그림을�Option을�바꾸어가면서�그린것이다.�

첫번째것이�Straighten이고�다음것이�Smooth,�그다음이�Ink이다.�
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�

�

�

�

�

③�연필도구를�리용하여�단추로�쓰일�도형을�하나�만든다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

④�도구칸에서�부분선택도구를�선택한다.�

부분선택도구� 는�그려진�모형의�모서리를�수정하거나�직선모형을�곡선으로�만들�

때�리용한다.�

부분선택도구를�리용하여�4각형의�모서리를�변형시켜보자.�

먼저�Stage에�4각형을�하나�그린다.�

�

�

�

�

�

�

�

�

�

�
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도구칸에서�부분선택도구를�선택하고�마우스를�4각형의�모서리로�가져간다.�그러면�

마우스지시자의�모양이� 과�같이�변한다.�이때�모서리를�찰칵하여�선택한다.�다음�Alt건

을�누른채로�모서리를�끌기하면�모서리가�곡선으로�바뀐다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑤�부분선택도구를�선택하고�방금�그린�도형을�찰칵한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

그림에서�보는바와�같이�부분선택도구로�도형을�선택하면�조종점들이�표시된다.�
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⑥�다음�그림에�표시한�조종점들을�부분선택도구로�선택하고�Delete건을�눌러�없앤다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

그러면�다음과�같이�된다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑦�다음�개별적인�조종점들을�선택하여�단추를�완성한다.�
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�

�

�

�

�

�

�

⑧�다음�도구칸에서�Paint�Bucket도구를�선택한다.�

Paint�Bucket도구� 는�Fill부분에�색을�칠해준다.�

Paint도구의�Option에는�Gap�Size와�Lock�Fill이�있다.�Gap�Size에서는�틈이�있는�

부분을�어떻게�처리하겠는가를�설정한다.�

�

�

�

�

�

�

�

�

�

�

�

Don’t�Close�Gaps:�테두리가�완전히�막힌�곳에만�적용된다.�

Close�Small�Gaps:�테두리에�미세한�틈이�있어도�적용된다.�

Close�Medium�Gaps:�테두리에�약간의�틈이�있어도�적용된다.�

Close�Large�Gaps:�테두리에�큰�틈이�있어도�적용된다.�
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⑨�Paint�Bucket�Tool을�리용하여�도형의�안에�색을�채운다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑩�다음�단추로�쓰일�도형을�Button�Symbol로�보관한다.�

⑪�다음�선택도구를�선택하고�단추를�두번찰칵한다.�

그러면�단추편집창문으로�들어간다.�

�

�

�

�

�

�

�

�

�

�

⑫�Over,�Down에�키프레임을�설정한다.�

�

�

�

�

�

�

�
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⑬�Over프레임을�선택하고�단추의�색을�바꾼다.�그리고�Down프레임을�선택하고�단

추의�색을�바꾼다.�

⑭�문자도구를�리용하여�Stage에�《재생》이라고�쓴다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

문자도구� 는� 본문을� 입력할� 때� 리용한다.� 문자도구를� 찰칵하면� Properties�

Panel에�본문편집을�위한�Option들이�나타난다.�

�

�

�

�

�

�

Stage에�본문을�입력하기�위해서는�도구칸에서�문자도구를�찰칵하고�Stage를�다시�찰

칵한다.�다음�본문을�입력하면�된다.�

�

�

�

�

�

�

�

�

�

�
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본문을�입력하면�본문칸이�넓어지는것을�알수�있다.�

문자도구를�찰칵하고�Stage에서�마우스를�끌어�본문입력칸이�나타나게�한�다음�본문

을�입력할�때에는�자리가�다�차면�줄바꾸기가�진행된다.�

�

�

�

�

�

�

�

�

�

�

�

�

확장가능한�본문칸에는�오른쪽�웃구석에�동그라미가�표시되고�확장불가능한�본문칸에는�

4각형이�표시된다.�4각형표식을�마우스로�두번찰칵하면�확장가능한�본문칸으로�변환된다.�

�

�

�

�

�

�

�

�

�

�

�

Properties� Panel을� 보면�알수�있는바와�같이�본문에는� Static� Text,� Dynamic�

Text,�Input�Text의�3가지�종류가�있다.�

Static�Text:�한번�입력한�본문이�변하지�않는다.�

Dynamic�Text:�자동적으로�내용이�갱신되는�본문칸을�만든다.�

Input�Text:�사용자가�본문(홈페지에서�사용자이름�입력칸과�같은)을�입력할수�있는�

본문칸을�만든다.�
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⑮�마찬가지�방법으로�단추를�하나�더�만들고�《정지》라고�쓴다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑯�앞에서�만든�《행성의�움직임묘사》파일을�열고�새로운�층을�만들고�《정

지》,�《재생》단추를�복사하여�붙인다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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⑰�Layer�3의�1번�프레임을�선택하고�Action�Panel에서�Actions\Movie�Control�

\stop를�두번찰칵한다.�

�

�

�

�

�

�

�

�

�

�

�

�

그러면�오른쪽에�stop라고�적혀진것을�볼수�있다.�stop�Action은�Movie의�재생을�멈

추는�기능을�수행한다.�

⑱�《재생》Button�Symbol을�선택하고�Action�Panel에서�다음과�같이�설정한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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⑲�《정지》Button�Symbol을�선택하고�Action�Panel에서�다음과�같이�설정한다.�

�

�

�

�

�

�

�

�

�

�

�

�

》�

�

�

�

�

Movie를�실행시켜본다.�

그러면�단추를�찰칵하는데�따라�Movie재생이�정지되였다�실행되였다�하는것을�알

수�있다.�
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실  습 

 

실습 1.  Motion Tween에 의한 Animation만들기�

①�Stage에�4각형을�하나�그린다.�

�

�

�

�

�

�

�

�

�

�

�

�

②�4각형을�Rectangle이라는�Graphic�Symbol로�보존한다.�

�

�

�

�

�

�

�

�

�

③�Timeline의�15번�프레임에�키프레임을�추가한다.�

�

�

�

�

�

�

�

�

�

�
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④�15번�프레임을�선택하고�4각형의�위치를�적당히�옮긴다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑤�Free�Transform도구를�리용하여�4각형을�회전시키고�크기도�변형시킨다.�

�

�

�

�

�

�

�

�

�

�

�

�
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⑥�30번�프레임에�키프레임을�추가한다.�

⑦�30번�프레임을�선택하고�4각형의�위치를�적당히�옮기고�크기를�조절하고�회전시

킨다.�

⑧�45번�프레임에�키프레임을�추가한다.�

⑨�45번�프레임을�선택하고�4각형을�선택하여�Delete건을�눌러�삭제한다.�

⑩�1번�프레임을�선택하고�4각형을�복사한다.�

⑪�45번�프레임을�선택하고�Ctrl+Shift+V건을�눌러�그자리에�붙여놓는다.�

�

�

�

�

�

�

�

�

�

�

�

⑫�1~45번�프레임전체를�선택하고�오른쪽찰칵하여�Create�Motion�Tween을�실행한다.�

�

�

�

�

�

�

�

⑬�Enter건을�눌러�Movie를�재생해본다.�

4각형이�회전하면서�크기가�변하는것을�알수�있다.�

⑭�1번�프레임에�있는�4각형을�선택한다.�

⑮�Properties�Panel의�Color항목에서�Advanced를�선택한다.�

�

�

�

�

�

�

�

�

�

⑯�Settings단추를�찰칵하면�Advanced�Effect대화칸이�나타난다.�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Advanced�Effect대화칸의�첫번째�입력칸에�4각형의�원래색의�몇%인가를�설정해준다.�

다음입력칸에�RGB�Alpha값을�입력하면�된다.�

⑰�1번�프레임의�4각형을�빨간색(R=255,�G=B=0)으로�만들기�위하여�첫번째�입력칸

에는�R=0,�G=0,�B=0,�Alpha=100으로�입력한다.�이렇게�되면�4각형의�원래색이�영향을�

미치지�못한다.�

두번째�입력칸에는�R=255,�G=B=0으로�입력한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

그러면�4각형이�빨간색으로�변하는것을�알수�있다.�

⑱�15번�프레임의�4각형을�선택한다.�
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⑲�앞에서와�같이�4각형의�색이�풀색(G=255)으로�되게�한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑳�30번�프레임의�4각형의�색을�푸른색(B=255)으로�설정하고�투명도를�0으로�한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⓰�45번�프레임의�4각형의�색을�빨간색(R=255)으로�설정한다.�

⓱�Enter건을�눌러�Movie를�실행해본다.�

4각형의�색이�변하는것을�알수�있다.�그리고�30번�프레임에서는�4각형이�없어졌다가�

다시�생겨난다. 
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실습 2. Shape Tween에 의한 Animation만들기 

①�도구함에서�문자도구를�선택한다.�

②�Stage에�Macromedia라고�입력한다.�

�

�

�

�

�

�

�

�

�

�

�

③�문자를�모두�선택하고�차림표띠에서�Modify→Break�Apart(혹은�Ctrl+B)지령을�

실행한다.�

�

�

�

�

�

�

�

�

�

그러면�문자들이�갈라진다.�

�

�

�

�

�

�

�

�

�

�

�

�
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④�Ctrl+B건을�누른다.�그러면�문자들이�도형으로�변한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑤�40번�프레임에�빈�키프레임을�추가한다.�

⑥�문자도구를�리용하여�Stage에�FLASH라고�입력한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑦�Ctrl+B건을�두번�눌러�문자를�도형으로�변환한다.�

⑧�1~39번사이의�임의의�프레임을�선택한다.�

⑨�Properties�Panel의�Tween항목에서�Shape를�선택한다.�

�

�

�

�

�

�

�
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그러면�Timeline에서�프레임들이�연풀색으로�표시된다.�

�

�

�

�

�

�

�

�

Motion�Tween이�적용되였을�때에는�Timeline의�프레임들이�연보라색으로�표시된다.�

�� Motion� Tween은� 시작키프레임이� 검은색점으로� 표시되고�

가운데프레임에는�연보라색배경에�검은색화살표가�표시된다.�

��Shape�Tween은�시작키프레임이�검은색점으로�표시되고�가운

데프레임에는�연록색배경에�검은색화살표가�표시된다.�

��마지막키프레임이�없는것과�같이�Tweening이�제대로�구성되지�

않은�경우에는�점선이�나타난다.�

��단일키프레임은�검은색점으로�표시된다.�회색프레임에는�앞의�

프레임과�같은�내용이�포함되여있으며�마지막프레임에는�빈�4각형이�표시된다.�

��Frame�Action을�지정한�프레임에는�소문자�a가�표시된다.�

��프레임에�Label이�포함되여있으면�빨간색기발이�표시된다.�

��프레임에�Anchor이름이�붙어있으면�노란색�닻이�표시된다.�

프레임에�Anchor이름을�붙이면�전진�또는�후진단추를�리용하여�프레임사이�혹은�장

면사이를�이동할수�있으므로�Movie탐색이�간단해진다.�

이와�같이�Timeline에서�프레임의�표시방법이�다�다르다.�

⑩�작업내용을�출력한다.�

결과를�보고�알수�있는바와�같이�Macromedia라는�문자가�모양이�달라지면서�FLASH

로�변하는것을�알수�있다.�
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실습 3. Shape Hint를 리용한 Animation만들기 

①�문자도구를�리용하여�Stage에�1이라고�입력한다.�

②�선택도구를�선택하고�Ctrl+Alt건을�누르고�끌기하여�하나�더�만든다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

③�문자들을�선택하고�Ctrl+B건을�눌러�도형으로�변환한다.�

④�30번�프레임에�빈�키프레임을�추가한다.�

⑤�문자도구를�리용하여�Stage에�2라고�입력하고�하나�더�복사한다.�
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�
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�
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�

�

�

�

�

�

�

⑥�문자들을�도형으로�변환한다.�

⑦�1~29번사이의�프레임을�선택하고�Properties�Panel의�Tween에서�Shape를�선택

한다.�

⑧�Enter건을�눌러�Movie를�재생해본다.�

⑨�1번�프레임을�선택한다.�

⑩�차림표띠에서�Modify→Shape→Add�Shape�Hint지령을�실행한다.�
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�

그러면�Stage에�원안에�a라고�씌여진�모형이�생긴것을�볼수�있다.�
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�

⑪�Shape�Hint를�하나�더�추가한다.�이번에는�b라고�씌여져있다.�

⑫�a,�b를�수자�1의�우아래에�다음그림과�같이�이동시킨다.�
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⑬�30번�프레임을�선택한다.�

⑭�a,�b를�다음그림과�같이�이동시킨다.�
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⑮�Enter건을�눌러�Movie를�재생해본다.�
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Shape� Hint를� 리용한쪽이� 자기� 모양을� 비교적� 유지하면서� 바뀌는것을� 알수� 있

다.�Shape�Hint는�최대�26개까지�사용할수�있다.�

�

�

실습 4. Mask를 리용한 Animation만들기 

①�Properties�Panel에서�Background를�찰칵하여�Movie의�배경색을�검은색으로�

설정한다.�

�

�

�

�

�

�

②�도구칸에서�문자도구를�선택하고�Macromedia�Flash라고�입력한다.�
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�

③�Transform�Panel에서�Copy�and�apply�transform을�찰칵하여�그�자리에�복사

한다.�

④�문자의�색을�약간�어두운�회색으로�바꾸어준다.�

⑤�문자를�약간�이동시켜�립체감이�나게�한다.�
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�

�

�

�
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⑥�Timeline에서�Insert�Layer를�찰칵하여�Layer를�추가한다.�

⑦�Layer�2의�1번�프레임을�선택한다.�

⑧�원형도구를�리용하여�Stage에�원을�그린다.�

�
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⑨�방금�그린�원을�선택하고�F8건을�눌러�Convert�to�Symbol대화칸을�연다.�

⑩�mask라는�Graphic�Symbol로�보존한다.�

⑪�Layer�2의�20,�40번�프레임에�키프레임을�추가한다.�

⑫�Layer�1의�40번�프레임을�선택하고�오른쪽찰칵하여�Insert�Frame을�실행하여�40번�

프레임까지�늘인다.�
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�

⑬�1번�프레임에�있는�mask�Graphic�Symbol을�선택하고�왼쪽으로�이동시킨다.�

�

�

�

�

�

�

�

�

�

�

�



� 95

⑭�20번�프레임에�있는�mask�Graphic�Symbol을�선택하여�오른쪽으로�이동시킨다.�
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�

⑮�40번�프레임에서는�1번�프레임에서와�같은�위치에�놓이게�한다.�

⑯�1~39번�프레임을�선택하고�오른쪽찰칵하여�Create�Motion�Tween을�실행한다.�
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�
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�

⑰�Timeline에서�Layer�2를�선택하고�오른쪽찰칵하여�Mask를�실행한다.�

�
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�

Movie를�실행해보면�Layer�2의�원형부분에서만�글자가�보이는것을�알수�있다.�
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